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1. User Manual Status

This is Release 4.00 version of the user manual.
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2. Warranty Statement

SentryScope is warranted to be free from defects in material and workmanship for three
(3) years under normal use and service, beginning on the date of shipment. This warranty
covers only hardware, software, and accessories as supplied by Spectrum San Diego, Inc.
Software, parts, and services are warranted for 90 days. Product repairs in warranty do
not restart the three (3) year period. Product repairs outside the warranty period are
warranted for 90 days. This warranty extends only to the original buyer or end user
customer of a Spectrum San Diego reseller.

Spectrum San Diego resellers shall extend this warranty on new and unused products to
their end user customers only but have no authority to extend a greater or different
warranty on behalf of Spectrum San Diego. Warranty support is available if product is
purchased through a recognized sales outlet or buyer has paid the applicable international
price. Spectrum San Diego reserves the right to invoice buyer for importation costs of
repair/replacement parts when product purchased in one country is submitted for repair in
another country.

Spectrum San Diego’s warranty obligation is limited, at Spectrum San Diego’s option, to
refund of the purchase price, free of charge repair, or replacement of defective product
which is returned to an authorized Spectrum San Diego service center within the
warranty period.

To obtain warranty service, contact your nearest Spectrum San Diego authorized service
center, obtain a Return Material Authorization (RMA) number, and send the product
(Spectrum San Diego will pay transportation costs) to your nearest authorized service
center. If the product failure is deemed to be from normal use and service, following the
warranty repair the product will be returned to buyer with transportation prepaid by
Spectrum San Diego. If Spectrum San Diego determines the failure is due to misuse,
alteration, accident, or abnormal condition of operation or handling Spectrum San Diego
will provide an estimate of the repair costs. Upon obtaining authorization for the work,
Spectrum San Diego will repair the product. Following the repair, the product will be
returned to the buyer transportation prepaid and the buyer will be billed for the repair and
return transportation charges (FOB shipping point).

THIS WARRANTY IS THE BUYER’S SOLE AND EXCLUSIVE REMEDY AND IS
IN LIEU OF ALL OTHER WARRANITIES, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF MERCHANABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. SPECTRUM SAN DIEGO SHALL NOT
BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES OR LOSSES, INCLUDING LOSS OF DATA,
WHETHER ARISING FROM BREACH OF WARRANTY OR BASED ON
CONTRACT, TORT, RELIANCE OR ANY OTHER THEORY.
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Since some countries or states do not allow limitation of the term of an implied warranty,
or exclusion of limitation of incidental or consequential damages, the limitations and
exclusions of this warranty may not apply to every buyer. If any provision of this
warranty is held invalid or unenforceable by a court of competent jurisdiction, such
holding will not affect the validity or enforceability of any other provision.
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3. Customer Support Information

Authorized service centers:

Spectrum San Diego, Inc.
10907 Technology Place
San Diego, CA 92127

Ph: 858 676-5382
Fax: 858 676-5385

Customer support contact information:

Phone support hours: 7AM – 4PM PST
Ph: 858 676-5382, x104
Fax: 858 676-5385
E-mail: support@spectrumsdi.com

mailto:support@spectrumsdi.com
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4. SentryScope Setup

a) Initial Screen

After installation of SentryWare, double click on the lock icon . The following
screen will appear (Figure 1):

Figure 1

The box in upper right hand corner displays the following status conditions:

Brick red – Camera not available
Bright red – Camera available, not recording images
Green – Camera available, recording images

If the SentryChroma color camera overlay is installed, this box will look as follows
(Figure 2) with status boxes for each camera:
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Figure 2

The remainder of this document will assume that SentryChroma is installed.

There are three (3) pull-down menus on top from left to right in Figure 2:

File – Save images as Windows® bitmaps, copy or print images, create image clips

Tools – Setup the camera before taking images

Help – Provides image and diagnostic data for maintenance purposes and software
release information. With an image on the screen select “Image Properties” and the
following screen will appear (Figure 3):
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Figure 3

This data is used for diagnostic purposes. Click under the blue arrow in Figure 4 to
switch to SentryChroma images. Select “Image Properties” again and the following
screen will appear (Figure 4):
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Figure 4

From the “Help” pull-down menu select “Diagnostic File” and the following screen will
appear (Figure 5):
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Figure 5

Navigate to the desired directory and select “OK”. The diagnostic file will be written to
this location for subsequent analysis by Spectrum San Diego. From the “Help” pull-down
menu select “About” and the following screen will appear (Figure 6) showing software
release and camera setup information:
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Figure 6

There are seventeen (17) operational icons from left to right in Figure 6:

Camera – Indicates camera readiness for taking images
Review – Provides tools to review any or all of the stored images
Zoom – Zooms using the cursor
Pan –  Pans image at current zoom level using cursor
Brighter – Increases brightness
Darker – Decreases brightness
Contrast Up – Increases contrast
Contrast Down – Decreases contrast
Gamma Up – Increases gamma
Gamma Down – Decreases gamma
Sharpen Up – Increases sharpness
Sharpen Down – Decreases sharpness
Extract Up -  Extracts objects from dark, light, or glary regions
Extract Down - Moves extracted objects back into background 
Reset – Resets image to default image enhancements
Undo – Undoes last image enhancement on displayed image
Arrow – Switches between black and white and color images
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The “Camera” button will be highlighted once SentryWare finds either one of the
connected cameras (SentryScope or SentryChroma). Pushing this button will initiate
image recording from the connected camera(s). IF BOTH CAMERAS CANNOT BE
FOUND BY SENTRYWARE THE “CAMERA” ICON WILL BE GRAYED OUT AND
UNUSABLE. MAKE SURE THE CAMERA(S) WITH A STATUS COLOR OF BRICK
RED HAVE POWER AND THE ETHERNET CABLES ARE PROPERLY
TERMINATED AT THE CAMERA AND THE SERVER. CALL SPECTRUM SAN
DIEGO IF THE CAMERA(S) STILL CANNOT BE FOUND BY SENTRYWARE.

b) Tools Pull-Down Menu – Camera Setup, Setup Tab

Select the “Tools” pull-down menu, and select “Camera Setup”. Select the “Setup” tab
and the following screen appears (Figure 7):

Figure 7

Fill in the appropriate boxes in Figure 7 with information about who owns the camera
and where it is installed. Camera location is important for multiple camera installations
being remotely monitored. This data will appear on the status bar of each camera
displayed by SentryManager.
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Check the “Password Control Enabled” box to password protect all camera settings. The
following screen appears (Figure 8):

Figure 8

The default password is “SentryScope” and is case sensitive. Enter the password. A
dialog box requesting confirmation will appear. Passwords must be at least eight (8)
characters and can be any combination of keystrokes. All camera setup functions, camera
utilities, the ability to start and stop the camera, and the ability to exit SentryWare will be
password protected. To change the password or undo password control, uncheck the
“Password Control Enabled” box. A dialog box will appear requesting the current
password. After successfully entering the password, the box will be unchecked. To enter
a new password, recheck the box and the dialog box requesting the new password will
appear.

c) Tools Pull-Down Menu – Camera Setup, SentryWare Tab

Click the SentryWare tab and the following screen appears (Figure 9):
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Figure 9

Click into the default path name where SentryWare will store image bitmaps for use in
other applications. A dialog box will appear as shown below in Figure 10. When a bitmap
is saved, the dialogue box will allow the default directory to be overridden. This control
is used for both SentryScope and SentryChroma.
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Figure 10

The Compression Settings dialog box provides two different compression settings for
SentryScope depending on customer requirements as follows:

Highest Image Quality – uses approximately 100-120 Gbytes of disk storage per
24 hours of continuous recording.

Recommended Setting – uses approximately 80-100 Gbytes of disk storage per 24
hours of continuous recording.

This control has no affect on SentryChroma.

To show status of remaining image storage, click on the “Tools” pull-down menu and
select “Disk Space Status”. A status bar will appear showing how much disk space is
remaining. If other dialogue boxes are open, the bar will be behind the boxes. Once the
other dialogue boxes are closed, the screen will look like Figure 11 below:
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Figure 11

The “Remote Clip Save Options” dialog box in Figure 10 is used when remote
SentryManager users are creating video clips. Select “SentryWare USB Drive” to write
the clip to a local USB drive. Select “SentryManager” to transfer the clip over a network
connection to the remote SentryManager work station.

The “Export Settings” box in Figure 10 is used to export camera settings for both
SentryScope and SentryChroma to a file, typically a network location or a removable
drive. This is useful in case of server failure to easily restore settings upon repair or if the
setup is to be replicated across multiple cameras. Select the “Export Settings” button and
the following screen will appear (Figure 12):
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Figure 12

Select the location and then click “Save”. Do not change the file extension.

The “Import Settings” button is used to restore saved settings or to perform initial camera
setup from already stored settings. Press the “Import Settings” button and the following
screen will appear (Figure 13):
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Figure 13

Navigate to the location and select the file name of the saved settings. Click the “Open”
button and settings will be restored.

The “Set Time Delete Mode” control is used in installations where images are prohibited
from being stored for more than a set amount of days. Click in the box and the following
screen will appear (Figure 14):
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Figure 14

Use the arrow buttons to select the appropriate number of days for both SentryScope and
SentryChroma. Images older than the setting will automatically be deleted first in first
out. Click in the box again to disable this control.

The “Image Section Export” feature is used to automatically export defined sections of
the image to a network drive. 3rd party software can then analyze these image sections
off-line in applications such as license plate recognition. Click on the “Image Section
Export” button and the following screen will appear (Figure 15):
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Figure 15

Click in the dialog box “Path to save image” and the following screen will appear (Figure
16):
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Figure 16

The desired location must be a network drive mapped by Windows. Once complete check
“Enable Region 1” and the following screen will appear (Figure 17):
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Figure 17

Using the cursor grab the top line of the box and position in the upper left hand corner of
the desired location within the image. Grab the lower right hand corner of box to size it
properly. Repeat these steps for regions 2-4 as necessary. Click the “Done” button when
finished. As each full image is stored on the server, jpeg images from one or all of the
regions will be exported to the defined location. This control will operate for either
SentryScope or SentryChroma images. Each region will have a unique file name (time
and data stamp followed be the region number) to allow for easy identification by 3rd

party software.

d) Tools Pull-Down Menu – Camera Setup, Camera Tab

Select the “Tools” pull-down menu, select “Camera Setup”, click on the “Camera” tab,
and the following screen will appear (Figure 18):
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Figure 18

SentryScope has two lens options 50mm and 85mm. The lens setting will be set at the
factory based on customer purchase order. The frame rate for SentryChroma is settable
from 2-12 frames per second. The “Set Temperature” dialog box controls the temperature
when the heater/blower turns on in outdoor applications. Set this appropriately to ensure
condensation does not form on the mirror or front window. This setting will control the
heater assembly in SentryChroma. For AC Line Frequency, select 60 Hertz for
installations in North America. The 50 Hertz setting is applicable in many international
installations.

Selecting “Enable Timer” will bring up the screen has shown in Figure 19 below:
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Figure 19

This setting is useful when there is a standard schedule of unattended and attended video
surveillance. The camera can be turned on or off by day and by start and stop time. If the
“On” column is set to “Off” the camera will not automatically start or stop on that day.

Click into the box marked “OFF”. This will toggle the timer to “ON” for that day. Click
into the “Start” and/or “Stop” boxes. Boxes will appear to set the hour and/or minute to
the desired time.

To set the timer to run through midnight, set the start time on the appropriate day and the
stop time for that day to any setting BEFORE the start time. On the next day set the stop
time to the appropriate setting and the start time to any setting BEFORE the stop time.
All time is in military format. Repeat these steps for as many days as appropriate.

The timer program turns the camera on and off once at the displayed time. If the operator
clicks the “Camera” button in the icon bar and manually turns the camera on or off, this
will override the timer function and the camera will stay turned on or off until the next
scheduled timer event. The timer controls both SentryScope and SentryChroma.
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e) Tools Pull-Down Menu – Camera Setup, Motion Tab

Enabling motion regions will cause images to be marked as alarmed only after
SentryScope has detected motion in the defined region. This is useful to quickly search
for images where motion occurred in key areas and/or alert operators in real time of
motion events. Select the “Motion” tab and Figure 20 below will appear:

Figure 20
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Up to four (4) regions can be defined. Click on the “Region 1” tab and then check the box
marked “On” and Figure 21 below will appear:

Figure 21

Grab the top line to move the box to the desired location. Grab the lower right hand
corner to set the size of the box.

Set the “Threshold”. This measures the absolute value change of the pixels in the motion
region. Set the “Percent” level (0%-100%). This setting measures the number of pixels in
the region that must change by the assigned threshold value before a motion event occurs.
Set the “Trigger Delay” (0-999 seconds). This setting measures how long the first two
conditions must be met before a motion even occurs. These three settings allow fine
tuning of the motion event to prevent as many false alarms as possible.

The first image that triggered the motion event will be marked as alarmed. All images
subsequently will be marked as alarmed until the motion conditions are no longer met.
The motion region will then reset and wait for the next event.

In Figure 21, the “Enable Audio Alarms” check box is used to globally enable or disable
the playing of all audio files for all motion regions or external triggers. This option will
appear under each motion region. Click this box. Then press the “Add Sounds” button
and Figure 22 below will appear:
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Figure 22

The “Sounds” folder is automatically created upon SentryWare installation with the
above listed default “.wav” files. Only “.wav” files can be selected. Use this folder and
files or navigate to a user defined folder with appropriate user defined “.wav” files.
Double click on the appropriate “.wav” file and Figure 23 below will appear:
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Figure 23

Up to five (5) audio files may be associated with these events. Repeat the steps in Figures
21 and 22 as many times as necessary. The “.wav” files will be played in the order added
as each motion event occurs that has audio files assigned.

To remove an audio file from the sequence, click on one of the files and the “Remove
Sound” button will be enabled. Click this button and the audio file will no longer be
played when the associated event occurs.

Motion zones and audible files can be set up in SentryChroma using these same controls.

Repeat these steps for each motion region as necessary. Click “Done” when finished.

f) Tools Pull-Down Menu – Camera Setup, Trigger Tab

A dry contact board is available as an option. When this board is installed the motion
zones discussed above are automatically associated with specific switches (see the
Installation Manual for more detail). In addition to playing audible files when a motion
event occurs the associated dry contact switch will be closed giving the operator
additional notification of an event. When the dry contact board is installed and the
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“Tools” pull-down menu is selected an additional tab will appear called “Trigger”. Select
this tab and Figure 24 below will appear:

Figure 24

Up to four external triggers may be used as inputs. Each trigger is assigned to a switch on
the dry contact board (see the Installation Manual for more detail). Each trigger can be set
up to be either normally open or normally closed. If the switch is normally open, leave
the “Normally Closed Switch” box unchecked. If the switch is normally closed, check
this box. Each trigger may have associated audible files. Follow the directions in outlined
for Figures 21-22 to assign sounds to the appropriate triggers.

Images will be marked alarmed as long as the switch is either closed or open, as defined
in Figure 24, allowing for quick searching of events. All images will be marked alarmed
until the switch changes state causing the trigger to reset and wait for the next event.

Repeat these steps as necessary for each trigger. Click “Done” when finished.

When the dry contact board is installed and/or motion enabled the “Tools” pull-down
menu will have an additional selection named “Motion or Trigger Status”. Select “Tools”
and this option and the following screen will appear (Figure 25):
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Figure 25

The number of motion events will be displayed for each region. Press the “Trigger”
button and number of events for each trigger will be displayed. “Reset” is used to set the
counters back to zero (0). The “Reset” button will have to be pushed once for “Triggers”
and once for “Motion” to reset both counters to zero (0).
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SentryScope and SentryChroma are ready to acquire images. Click the “Camera” icon to
being taking images and the following screen will appear (Figure 26):

Figure 26
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Click below the blue arrow to switch to SentryChroma images and the following screen
will appear (Figure 27):

Figure 27
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g) Tools Pull-Down Menu – Camera Utilities, Focus

SentryScope and SentryChroma are now ready to be focused. With the blue arrow
pointed at SentryScope, from the “Tools” pull-down menu, select “Camera Utilities” and
the following screen will appear (Figure 28):

Figure 28

Focus at dusk when the lens aperture is more open than in well-lighted conditions. AUTO
FOCUS RESULTS WILL NOT BE OPTIMAL IF PERFORMED IN DARK OR VERY
BRIGHT CONDITIONS.

Click the “Auto Focus” button and SentryScope will automatically adjust to a 4X zoom
level and focus around the center of the displayed image. This will take up to thirty (30)
seconds during the day and up to one (1) minute at night. During this time a series of
images will be displayed showing focus progress and a status message will be displayed
as shown below in Figure 29:
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Figure 29
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When Auto Focus is complete, the screen will look like Figure 30 below.

Figure 30

Use the “Manual Lens Control” controls to fine tune the focus. Zoom further into an area
or item of interest. Use the controls in Figure 30 to fine tune the focus on the area of
interest. Observe the affects of each focus step. The small step is the smallest adjustment
that can be made with the lens. The big step is equal to five (5) small steps. The screen
will look like Figure 31 below:
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Figure 31

Keep the zoom at its current position and SentryScope will continue to show each image
zoomed into the area of interest. Alternatively, point the cursor anywhere in the image
and right click until the image is back to its’ original state.



SentryScope User Manual 38

Using the blue arrow switch to SentryChroma and Figure 32 below will appear:

Figure 32

There are two modes of focus. Normal mode displays images around one per second.
Press the “Normal Mode” button, the mode will switch to “Focus Mode”, and Figure 33
below appears:
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Figure 33

This mode displays images at the frame rate specified in Camera Setup. For best results,
zoom in on an edge in the field of view (for instance a line delineating parking spaces in
Figure 33) and use the big steps until the line is sharp.

Click “Done” when finished.

h) Tools Pull-Down Menu – Camera Utilities, Gain

SentryScope and SentryChroma gain values are now ready to be set. Using the blue
arrow, switch back to SentryScope and click on the “Gain” tab. Figure 34 below will
appear:
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Figure 34

Set the values higher to increase the capability for SentryScope to bring out data in dark
areas, areas in shadows, or glary areas. This will be at the expense of other areas of the
image possibly saturating. Set the values lower to increase SentryScope’s capability of
bringing out data in bright areas at the expense of other areas possibly being too dark.
SentryScope automatically switches from the Day to Night settings and vice versa. The
“Set Gains” button must be pressed for any changes to take affect. See the “SentryScope
Camera Gain Setup” document for more detail on these settings.
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Using the blue arrow, switch to SentryChroma images and Figure 35 below will appear:

Figure 35

Follow the instructions outlined for Figure 34 above for the “Day” setting.
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i) Tools Pull-Down Menu – Camera Utilities, Position

SentryScope and SentryChroma are now ready to be positioned. Using the blue arrow,
switch to SentryScope images and click on the “Position” tab. Figure 36 below will
appear:

Figure 36

These controls are used to overlay the images as close to exact as possible. Make sure
both cameras are recording images (indicated by green in both status boxes) so that the
changes are immediately visible in subsequent images. First position SentryScope. The
value for “Left” determines where the mirror begins sweeping across the field of view. If
there is a vertical shadow on the left side of the image, increase this number because the
front window in the camera enclosure is in the field of view. If there is a vertical shadow
on the right side of the image, decrease this number (See Installation Instructions for
more detail).

SentryChroma positioning tools utilize an X,Y grid scheme with 0,0 being the upper left
hand corner of the image. Increasing the “Left” value moves the image away from the
zero position or moves the image to the right. Decreasing this value moves the image
back towards the zero position or moves the image left. Increasing the “Top” value
moves the image away from the zero position or moves the image down. Decreasing this
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value moves the image back towards the zero position or moves the image up. The
“Width” and “Height” controls crop the image to fit the 5:1 aspect ration of SentryScope.

Once complete with the Focus, Gain, and Position adjustments, SentryScope and
SentryChroma are covering the field of view in ultra-high resolution black and white and
high frame rate color images.

j) Tools Pull-Down Menu – Camera Setup, Camera Tab, Set Field of
View

The “Set Field of View” feature is used to fine tune the horizontal field of view anywhere
between 36° to a full 90°. This adjusts the start and stop position of the mirror and could
increase the image rate to as much as two images per second. Click the “Camera” button
to stop taking images. Select the “Tools” pull-down menu and select “Camera Setup”.
Select the “Camera” tab and click on “Select Field of View” and the following screen
will appear (Figure 37):

Figure 37
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SentryScope will acquire one image and Figure 38 below will appear:

Figure 38
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A box with a red border will be shown. Using the cursor, grab the lower right hand corner
and size the box appropriately. Then grab the top line of the box and position it in the
field of view as desired. The screen will look like Figure 39 below. Note that only the
horizontal aspect can be modified.

Figure 39

When finished, click “Set Area”, then “Done”. Click the “Camera” icon again to begin
acquiring images. Setting a new field of view is only allowed from SentryScope. Use the
“Position” tab under “Camera Utilities” to re-position SentryChroma to overlay the new
field of view.
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k) Tools Pull-Down Menu – Camera Setup, Camera Tab, Set Mask
Zones

The “Set Mask Zones” feature is used to “gray out” certain portions of the image. This
allows the masking out of areas in the image that are deemed to be “private” as well as
portions of the image that aren’t critical to monitor or record that may have substantial
motion (trees, sky, etc.). This has the affect of reducing file size as compression is greater
in masked out zones. Select the “Camera” tab and click on “Set Mask Zones”. If there
isn’t a valid image on the screen the following will appear (Figure 40):

Figure 40
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SentryScope will acquire one image and Figure 41 below will appear:

Figure 41
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Up to four regions in the image can be masked. Click “Mask Zone 1” and “Mask Zone 2”
and Figure 42 below will appear:

Figure 42

Boxes with red and yellow borders will be shown. Using the cursor, grab the lower right
hand corner of each box and size appropriately. Then grab the top line of each box and
position it in the field of view as desired. Note that the zones can be overlapped to better
fit particular regions. Note also that the borders will be snapped to a grid and the area of
the box will be slightly larger than drawn. To compensate, center the box in the particular
region and make it slightly smaller than required. Repeat these steps for Mask Zones 3
and 4 as appropriate.
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When finished, click “Done”. Click the “Camera” icon again to begin acquiring images.
Figure 43 below will appear, with the mask zones “grayed out”:

Figure 43

The masked zones will be approximated in SentryChroma. Use the blue arrow to switch
images and the following screen will appear (Figure 44):
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Figure 44
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l) Tools Pull-Down Menu – SentryManager User(s) Logged In

Multiple remote SentryManager users may be looking at images from the same
SentryScope camera. However only one user may be making configuration changes using
the Camera Setup or Camera Utilities controls. If the “Tools” pull-down menu is selected
and another user is already logged in and reviewing or making configuration changes,
figure 45 below will appear with a “Busy” indication:

Figure 45

If “Camera Setup” or “Camera Utilities” is selected, Figure 46 below will appear
showing information on the user already logged in:
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Figure 46

This condition will continue until the remote user is logged out.

m) Tools Pull-Down Menu – Auto Pan Controls

The Auto Pan feature provides tools to set up sub-regions in the field of view and zoom
directly into individual or automatically tour of all the created sub-regions. This gives an
operator viewing live images a method to easily view specific regions of the image on a
regular basis, similar to the auto tour feature of conventional CCTV pan, tilt, and zoom
systems. It is important to note that even as SentryScope is taking a tour, it is still
recording the entire 90° in ultra-high resolution. Press the “Camera” button to stop taking
images if necessary.
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Select the “Tools” pull-down menu, and the select “Auto Pan Controls”. Figure 47 below
will appear:

Figure 47



SentryScope User Manual 54

The auto pan tool bar appears. It may be moved by left clicking on the blue square and
dragging it to the appropriate spot on the screen. The tool bar will remain in the new
position until relocated.

Left click the “?” button and a help screen will appear.

Point the cursor into the desired region of the image and zoom in as far as necessary.
Right click in the blue square above the question mark and Figure 48 below will appear:

Figure 48
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Click on “Add New” and Figure 49 below will appear:

Figure 49
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Repeat these steps for up to a total of 10 pre-set sub-regions. The bottom button in the
tool bar is the button to press to automatically tour all of the pre-sets. Figure 50 below
shows 4 pre-sets:

Figure 50
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Right click on the bottom auto pan button and Figure 51 below will appear:

Figure 51

Set the delay in seconds (up to 59 seconds) before SentryScope displays the next pre-set.
Click the “Camera” button to begin taking images. Press any of the pre-set buttons to
zoom directly into the assigned sub-region. Press the bottom auto pan button to
sequentially tour through all of the defined pre-sets.

To delete or change the pre-sets, click the “Camera” button to stop taking pictures. Zoom
into a different portion of the image then right click the appropriate pre-set. Figure 52
below will appear:
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Figure 52

Select “Set Current” to reassign the pre-set to the new zoomed area. To delete a pre-set
position, right click on the appropriate button and select “Delete Current”.

The pre-set regions can be added, changed, or deleted in either SentryScope or
SentryChroma images. The sequential tour of all pre-sets can be initiated in either
camera.

n) Auto Pan Controls, Internal Motion Detection and External Triggers

The Auto Pan controls can be used in conjunction with internal motion detection or
external triggers to automatically zoom into a portion of the image when an event occurs.
This gives an operator viewing live images immediate notification of an event that may
need attention. To operate with external triggers the optional dry contact board must be
installed.
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Using the steps outlined in section 4d, set up one or more motion zones in SentryScope.
In the following example motion regions 1 and 2 have been configured. Turn the camera
off and right click on pre-set button 1 and Figure 53 below will appear:

Figure 53

Select the appropriate motion region. Click the “Camera” button to begin taking images.
If motion occurs in the selected region, SentryScope will automatically zoom into the
assigned pre-set button, in this example pre-set button 1.

Note that for best results, the sub-region assigned to pre-set button 1 should roughly be in
the same position in the overall image as the associated motion region.

SentryScope operates in a similar fashion when the camera has been set up with external
triggers. Follow the steps in section 4e to enable one or more triggers. Pre-sets can be
assigned to external triggers by highlighting “Select Trigger Region” in Figure 53 above
and selecting the appropriate trigger. When an external trigger event occurs, SentryScope
will automatically zoom into the assigned pre-set button.

Motion zones may be set in either SentryScope or SentryChroma. When a motion or
trigger event occur, the automatic zoom will take place regardless of the image displayed
on the screen (black and white or color).
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5. SentryScope Image Analysis

Once SentryScope and SentryChroma have captured images there are multiple ways to
find stored images of interest. All stored image review and enhancement capabilities are
available while the camera is recording live images with the exception of the clip
generation and review capabilities described in 5k.

a) Analyze Currently Displayed Image

Point the cursor anywhere on the currently displayed image. Use the zoom tool or any of
the image enhancement tools to analyze the currently displayed image. When an image
from SentryChroma is displayed the screen will look as follows (Figure 54):

Figure 54

Note that the “Extract” buttons are grayed out and not available for SentryChroma.

b) Thumbnail Review

Click the “Review” button on the icon bar. The screen below will appear (Figure 55):
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Figure 55

Each field in the “Start At” and “Show Until” boxes can be individually edited. Use these
controls to expand or limit the number of images for review. Click the arrow buttons to
the right of the box and a calendar will appear as follows (Figure 56):
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Figure 56

This will allow selection of the month by using the left or right arrows and the day by
selecting the appropriate day. When finished, click anywhere outside the calendar box.
In all cases thumbnail review cannot be started before the first image taken and end past
the last image taken. Nor can the “Show Until” field be modified to be before the “Start
At” field.

The scroll knob above the review commands can be grabbed and dragged back and forth
to the appropriate time. Use the date and time stamp above and left of the displayed
image to help zero in on the correct timeframe. Use the “2Min”, “10Min”, “Hour”,
“5Hour”, “Day”, or “All” buttons to limit the amount of images available for review
when using the scroll bar. Click the “2Min” button and Figure 57 below will appear:
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Figure 57

Notice the tickers below the scroll bar. This indicates that as you move the scroll bar, a
smaller number of images will be skipped allowing for finer selection of images of
interest.

The review controls can also be used to find the exact image(s) of interest. From left to
right, the buttons in Figure 57 operate as follows:

Rewind - Fast rewind (approximately 10 images per second)
Step Back - Step back one image at a time
Stop - Stop rewind, fast forward, or play
Play - Display each image (approximately 1 image per second
Step Forward - Step forward one image at a time
Fast Forward - Fast forward (approximately 10 images per second)

Clicking the scroll knob will have the same affect has clicking the “Stop” button.
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c) Thumbnail Review – Motion Search

Motion search is also available. In Figure 57, click the “Set Search Area(s)” button and
Figure 58 will appear:

Figure 58
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Up to four search regions can be defined. Check the box for Region 1, and Figure 59 will
appear:

Figure 59

Grab the top line of the box and place it in the desired position. Grab the lower right hand
corner of the box and size it appropriately. Set the threshold of change. As the number
goes higher, more change is required in the defined area to meet the search criteria.
Therefore, fewer images will be found. As the number is lowered, more images will meet
the criteria. Repeat these steps for Search Regions 2, 3, and 4 as necessary. When
complete click “Done”.

Use the “Search” controls. “Search Forward” will search forward from the current image
displayed in review mode until the search criteria are met for anyone of the search
regions. “Search Back” will search backward from the current image. As each image is
found, the color of the box for that region will be quickly displayed. Once a motion
search image is displayed on the screen, use the motion search controls to continue
searching or use the review controls to review stored images immediately before and/or
after the matched image.

In review mode thumbnail images at lower resolution are being shown. Once you have an
image on screen for analysis, the first click of the cursor in a region of interest will
automatically load the full resolution image and zoom into that region.
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d) Thumbnail Review – Search for Internal Motion Events

If there are motion zones enabled in SentryScope the number of events occurred in each
motion region since the last time the “Reset” button was clicked will be shown in the
status box as in Figure 60 below:

Figure 60
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Click the “Review” button in the icon bar and then the “Internal” tab and the following
screen will appear in Figure 61:

Figure 61

To search for images associated with each motion region, check the box next to the
appropriate regions. Clicking the “Next Event” or “Previous Event” boxes will search for
the first image in either the next or previous event for the region(s) selected. As each
image is found the color of the box for that region will be quickly displayed. If multiple
regions are selected, images from events are displayed in the order recorded.

The specific region(s) that caused the image to be marked as alarmed will be bolded in
the display. Note that Region 2 is in bold font in Figure 61.

Once an internal motion detection image is displayed on the screen, use the event search
controls to look for another event or use the review controls to review stored images
immediately before and/or after the alarmed image.
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e) Thumbnail Review – Search for External Trigger Events

In Figure 61 above, click on the “Trigger” button. If there are external triggers enabled in
SentryScope the number of events occurred for each trigger since the last time the
“Reset” button was clicked will be shown in the status box as in Figure 62 below:

Figure 62
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Click the “Review” button in the icon bar and then the “External” tab and the following
screen will appear in Figure 63:

Figure 63

To search for images associated with each trigger, check the box next to the appropriate
triggers. Clicking the “Next Event” or “Previous Event” boxes will search for the first
image in either the next or previous event for the trigger(s) selected. If multiple triggers
are selected, images from events are displayed in the order recorded.

The specific trigger(s) that caused the image to be marked alarmed will be bolded in the
display. Note that Trigger 2 is in bold font. Once an external trigger image is displayed
on the screen, use the event search controls to look for another event or use the review
controls to review stored images immediately before and/or after the triggered image.

f) Image Analysis and Enhancement

Once the correct image has been loaded use any of the following enhancement tools in
Figure 63 to identify suspicious activity:
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1) If not already pushed, click the “Zoom” button in the icon bar and then point
the cursor at the area of interest. Each left click of the mouse is equal to 2X
zoom.

2) Click the “Pan” button to look at a different area of the image while zoomed
in. Move the cursor to the new area of interest and left or right click the
mouse. This will realign the screen around the cursor. Note that the “Pan”
button is only useable when zoomed into an image. If the full image is
displayed, the “Pan” button will be grayed out.

If “Pan” is enabled, “Zoom” is accessed by pushing the “Zoom” button or
pushing the “Pan” button again. If “Zoom” is enabled, “Pan” is accessed by
pushing either the “Pan” button or pushing the “Zoom” button again.

3) Use the “Brighter” or “Darker” buttons to adjust the brightness. This adjusts
the value of each pixel.

4) Use the “Contrast Up” or “Contrast Down” buttons to adjust the contrast. This
increases or decreases the difference between pixel values.

5) Use the “Gamma Up” or “Gamma Down” buttons to adjust the gamma. This
allows more control over specific areas of interest. For instance gamma can
increase the contrast in darker areas of an image with little or no affect in the
brighter regions.

6) Use the “Extract Up” button to bring out objects in dark, light or glary
backgrounds. This is an advanced image analysis tool which operates in
specific sub-regions of the image where there is not a great deal of difference
between pixel values. Information in darker, lighter, or glary areas is often
unusable. Extract displays images based upon the relative brightness of the
image sub-region while attempting to maximize the amount of usable
information to the viewer (only available for SentryScope).

7) Use the “Extract Down” button to move objects back into the background
(only available for SentryScope).

8) The “Reset” button will take the image back to its original settings. This is
useful when the image has been enhanced past the point of knowing the
starting point.

9) The “Undo” button will flip-flop image enhancement steps. Press the “Undo”
button once. The last image enhancement step will be reversed. Press it again
and the last image enhancement step will be reapplied. This is useful to watch
the affects of a single enhancement step.
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g) Zoom

Figure 64 below shows the result of zooming one level into an image.

Figure 64

A subset of the review controls are still visible and can be used to review forward and
back at the current zoom level. If the controls are blocking a sub-region of interest, the
bar can be dragged to another spot on the screen. Zoom back out to the originally
displayed image to see the entire set of review controls. The boxes containing numbers
below the review controls are used in image averaging described in the next section.

Click the up arrow to switch to color images and Figure 65 below will appear:
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Figure 65

Note that image averaging is not available. Click the up arrow button again to switch
back to SentryScope.

h) Image Averaging

Image averaging is available for all SentryScope images. It is generally useful in low
light conditions where random noise is present in the image.
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Using the review controls find an image after dark. Zoom into the image and Figure 66
below will appear:

Figure 66

There are a series of numbers below the review controls (2,4,10,25,50,120). These
represent the number of images to average with the image currently on the screen. By
using image averaging, the noise in the image is cancelled out leaving only a clear view
of the object.
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Click “120” in Figure 66 and Figure 67 below will appear:

Figure 67

Note that an image should be selected with very little motion or changes in the images
preceding or subsequent to the image of interest. This will prevent “ghosts” from
appearing as a result of averaging. Note also that this capability only works with
stationary objects. Moving objects will be “averaged” out of the final result.
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i) Reviewing SentryChroma Images

Using the blue arrow, switch to SentryChroma and the following screen will appear
(Figure 68):

Figure 68

As previously mentioned the “Extract” buttons are grayed out and not available. Note that
the “Rapid Search Tools” are not available. All searching must be done using images
from SentryScope. Notice also that the “Clip Generator” button is grayed out. Clips must
be generated from SentryScope images. See section k below for more detail on clip
generation.

Image averaging is also not available on SentryChroma images.

All other search and image enhancement features operate in the same fashion as
SentryScope.
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j) Saving Images for Other Uses

Often images are required to be saved and used in other applications or for use in
criminal trials. If necessary, click the “Camera” button to turn the camera off. Select the
“File” pull-down menu and the following screen will appear (Figure 69):

Figure 69

“Save Displayed Image” will save the portion of the image on the screen (full or
zoomed). “Save Full Resolution Images” will save the entire image as taken by the
camera and could be as large as 21 million bytes. “Copy Image to Clipboard” will copy
the displayed portion of the image to the Windows® clipboard. “Print Displayed Image”
will print the displayed image to the selected printer along with a time and date stamp.
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If either “Save” function is selected, Figure 70 below will appear:

Figure 70

The default directory from “Camera Setup” is shown. Enter the file name. The default
directory where the image will be saved can be overridden by clicking on the down arrow
key in the “Save in:” box above and selecting a different directory. Click “Save” to save
the image currently on the screen. The image will be saved in an uncompressed bitmap
format that is compatible with most PCs and Windows operating systems.

This file can now be inserted into other applications, e-mailed to another party, printed,
or other actions as necessary.

Selecting “Copy Image to Clipboard” will copy the displayed image to the Windows®

clipboard. To copy only a certain area of the displayed image, use the “Zoom” button to
zoom into the area of interest before clicking the “Copy” button. This allows images to be
copied from the clipboard into other Windows applications by using the “Edit” and
“Paste” functions.
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k) Creating Video Clips

SentryWare provides a way to easily create one or more video clips and copy them to a
user definable destination (typically a removable media such as CD or USB drive) along
with viewer software to review and analyze the images. This makes it easy to transport a
series of images to where ever they need to be analyzed. Use the “Rapid Search Tools” to
find an image of interest, typically the first image of the clip. If necessary click the
“Camera” button to turn the camera off. Under the “File” pull-down menu, select “Clip
Generator” or click the “Clip Generator” button under the “Show Until” dialog box and
Figure 71 below will appear:

Figure 71

Click on the down arrow to navigate to the desired destination. Click “OK” and Figure 72
below will appear:
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Figure 72

Click the “Set New Path” button to change the destination. The size of the clip is
displayed. Check the appropriate boxes to have both SentryScope and SentryChroma
images or one or the other on the clip. Click the “Help” button to get instructions on the
use of the clip generator tools.



SentryScope User Manual 80

Click “Add Clip” and Figure 73 below will appear:

Figure 73

Enter a description of the video clip.

Use the dialog boxes under “Start” and “Stop” to define the length of the clip. Click
“Done” to add the clip to the CD image or “Cancel” to start over. After clicking “Done”,
a status box saying “Please Wait While SentryWare Adds the Clip” will be displayed
followed by Figure 74 below:
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Figure 74

The title of the clip will be in the gray clip status box. The amount of space used will be
displayed. The review tools are now activated to allow review of the selected images if
necessary.
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If the clip is not desirable, highlight the clip in the status box and hit “Delete” on the
keyboard. Figure 75 will appear:

Figure 75

Click “Yes” to start over or “No” as appropriate.

Multiple clips can be written to the desired location. Click the “Add Clip” button and
repeat the steps from Figure 73. As each clip is added, the name of the clip will appear in
the gray status box and the total space used will be updated.
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When the clip(s) are ready, click “Create” and Figure 76 below will appear.

Figure 76

A dialog box will appear asking if password protection of the video clip is necessary.
Click “Yes” if the clip(s) can only be viewed under password control. If password
protection is desired, dialog boxes will appear asking for the password and confirmation.
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When the clip(s) are ready click “Create” and Figure 77 below will appear while
SentryWare prepares the clip image:

Figure 77
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In this example a CD is the destination. Once the clip image is prepared, SentryWare will
call the Windows CD writing tool and Figure 78 below will appear:

Figure 78

Place a writeable CD in the drive and select “Write these files to CD”, the top selection in
the left side bar. Follow the instructions in the dialog boxes. When complete the disk will
eject and control will return to SentryWare. The CD will contain viewer software along
with the images and can now be played in the vast majority of PCs running Windows 95
and up. The clip should auto-start. If not, use Windows Explorer to display the CD
contents and double-click on the “autorun” MS-DOS batch file.

If the destination is not a CD (optical drive), but a network, removable, or hard drive
there will no interim steps. The images and viewing software will be written as soon as
SentryWare completes building the clip image. Double-click on the “autorun” MS-DOS
batch file to run the clip.
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